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Introduction 

Do you need to get your work done with Excel—smoothly, confidently, and as quickly as 
possible? 

If so, you’ve picked up the right book. 

Who Is This Book For? 
This book is designed to help beginning and intermediate users get up to speed quickly with 
Excel 2011 for Mac and immediately become productive with it. 

If you need to learn to use Excel to accomplish everyday tasks, at work or at home, you’ll 
benefit from this book’s focused approach and detailed advice. You can either start from the 
beginning of the book and work through the chapters in sequence, or use the Table of Contents 
or the Index to find the topic you need immediately, and then jump right in there. 

What Does This Book Cover? 
This book contains three parts that cover everything you need to know to use Excel 2011 
effectively. 

Part 1, “Becoming Proficient with Excel:Mac,” makes sure you know essential moves for 
using Excel: 

• Chapter 1, “Learning the Secrets of the Excel:Mac Interface,” teaches you 
the ins and outs of the four main means of controlling Excel: the Ribbon, 
the toolbars, the menus, and keyboard shortcuts. You grasp how to 
navigate through worksheets and workbooks; learn about quick ways of 
entering text in workbooks; and use splitting, freezing, and custom views to 
display exactly the items you need. 

• Chapter 2, “Configuring Excel:Mac to Suit the Way You Work,” shows you 
how to make Excel work you way by setting the most important 
preferences and by customizing the keyboard shortcuts, toolbars, menus, 
menu bars, and Ribbon. You also learn how to open workbooks 
automatically when you launch Excel and how you can save the layout of 
multiple open workbooks as a workspace that you can instantly restore. 
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• Chapter 3, “Creating Effective Workbooks and Templates,” explains how to 
create workbooks in which you can enter, edit, and manipulate data 
quickly and effectively. You learn which file formats to save the workbooks 
in, how to how to add property information to help you identify workbooks 
when searching, and how to make the most of templates—including 
creating templates of your own. You also learn how to organize worksheets, 
lay data out effectively, define named ranges to make navigation easier, 
and create a collapsible worksheet. 

• Chapter 4, “Formatting Your Worksheets Quickly and Efficiently,” shows 
you how to format worksheets quickly and efficiently using the various 
tools that Excel provides. We start with formatting rows and columns—
everything from changing column width and row height to inserting and 
deleting rows and columns and hiding sensitive data. Then we go through 
how to apply straightforward formatting, how to apply conditional 
formatting to quickly flag values that need attention, and how to use data 
validation to check for invalid entries. Finally, we cover how to save time by 
using table formatting or Excel’s styles, and how to add headers and footers 
to worksheets. 

Part 2, “Performing Calculations and Presenting Data,” gets you up to speed with formulas, 
functions, charts, and graphical elements such as pictures and sparklines: 

• Chapter 5, “Performing Custom Calculations with Formulas,” makes sure 
you know what formulas and functions are, and what the difference 
between the two is. This chapter then teaches you how to create your own 
formulas using Excel’s calculation operators, starting with straightforward 
formulas that use a single calculation operator each, and then moving on 
to more complex formulas that use multiple calculation operators. You also 
learn how to override Excel’s default order for evaluating operators and 
how to troubleshoot common problems that occur with formulas. 

• Chapter 6, “Using Excel’s Built-In Functions,” explains how to insert 
functions in your worksheets using the various tools that Excel provides, 
find the functions you want, and point the functions to the data they need 
for the calculations. The second part of the chapter reviews Excel’s 
different categories of functions, such as database functions, logical 
functions, and math and trigonometric functions, and gives examples of 
how to use widely used functions. 

• Chapter 7, “Creating Clear and Persuasive Charts,” teaches you how to 
present data clearly and persuasively using Excel’s wide range of charts. 
You learn the different ways you can place charts in worksheets, the 
components of charts, and the types of charts you can use. We then dig 
into how you create a chart from your data, lay it out the way you want, and 
then give it the look it needs. We also look at ways of reusing the custom 
charts you create and ways of using Excel charts in Word documents or 
PowerPoint presentations. 

• Chapter 8, “Using Data Bars, Color Scales, Icon Sets, and Sparklines,” 
shows you how to add visual appeal to your worksheets by using those four 
types of single-cell graphical elements. You quickly get the hang of using 
data bars to compare the values in a range of cells, adding color scales to 
adjust the background colors of cells to provide a visual reference to their 
values, and using icon sets to provide quick visual reference to 
performance. And you learn to create single-cell charts using sparklines. 
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• Chapter 9, “Illustrating Your Worksheets with Pictures, SmartArt, and 
More,” explains ways of giving your workbooks visual interest by adding 
graphics, shapes, SmartArt diagrams, and WordArt items. You learn how to 
make a picture look the way you want it, how to position graphical objects 
wherever you need them, and how to position graphical items relative to 
cells and how to arrange graphical objects to control which ones are visible. 

Part 3, “Analyzing Data and Sharing and Automating Your Workbooks,” shows you how to 
analyze, manipulate, and share the workbooks you’ve built: 

• Chapter 10, “Creating Tables with Databases,” covers using Excel’s tables 
to create databases for storing information, sorting it, and filtering it to find 
the records you need. You also learn how to put Excel’s database functions 
to work with tables. 

• Chapter 11, “Solving Business Questions with What-If Analysis, Goal Seek, 
and Solver,” teaches you how to analyze your data using four powerful 
tools. You learn to use data tables to assess the impact of one or two 
variables on a calculation and how to use scenarios to experiment with 
different sets of values without changing your core data. You also learn to 
use Goal Seek to solve single-variable problems and Solver to crack multi-
variable problems. 

• Chapter 12, “Analyzing Data with PivotTables,” explains what PivotTables 
are and how you can use them to examine the data in your worksheets and 
find the secrets it contains. You learn how to create PivotTables either 
using Excel’s automated tool or by placing fields manually where you need 
them, how to change the PivotTable once you’ve created it, and how to sort 
and filter the data it contains. 

• Chapter 13, “Collaborating and Sharing with Macs and Windows PCs,” 
takes you through ways of sharing your workbooks with others. We start by 
covering how to print worksheets, create PDF files from them, and export 
data to comma-separated values files. We then move on to sharing 
workbooks so that multiple people can work on them at the same time, 
tracking the changes if necessary so that you can review them. We finish by 
looking at how to merge changes from separate copies of the same 
workbook into one workbook and how to consolidate multiple worksheets 
into a single worksheet. 

• Chapter 14, “Automating Tasks with Macros and VBA,” shows you how to 
record macros to eliminate the drudgery of performing the same task over 
and over again. You learn how to run macros using the menus or toolbars, 
using keyboard shortcuts, or even by assigning them to worksheet objects 
such as command buttons. I also introduce you to the Visual Basic Editor 
and show you how to edit a macro to change what it does.  

Conventions Used in This Book 
This book uses several conventions to make its meaning clear without wasting words: 

• Ribbon commands. The ~TRA arrow shows the sequence for choosing an 
item from the Ribbon. For example, “choose Layout ~TRA Print ~TRA 
Preview” means that you click the Layout tab of the Ribbon (displaying the 
tab’s contents), go to the Print group, and then click the Preview button. 

• Menu commands. The ~TRA arrow shows the sequence of commands for 
choosing an item from the menu bar. For example, “choose Data ~TRA 
Data Table” means that you open the Data menu and then click the Data 
Table item on it. 
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• Special paragraphs. Special paragraphs present information that you may 
want to pay extra attention to. Note paragraphs contain information you 
may want to know; Tip paragraphs present techniques you may benefit 
from using; and Caution paragraphs warn you of potential problems. 

• Check boxes. Excel uses many check boxes—the square boxes that can 
either have a check mark in them (indicate that the option is turned on) or 
not (indicating that the option is turned off). This book tells you to “select” 
a check box when you need to put a check mark in the check box, and to 
“clear” a check box when you need to remove the check mark from it. If the 
check box is already selected or cleared, you don’t need to change it—just 
make sure it’s set the right way. 

• Keyboard shortcuts. In Excel, you can often save time and effort by using a 
keyboard shortcut rather than a Ribbon command or a menu command. 
This book uses + signs to represent keyboard shortcuts. For example, 
“press Cmd+S” means that you hold down the Cmd key, press the S key, 
and then release the Cmd key. “Press Cmd+Option+T” means that you hold 
down the Cmd key and the Option key, press the T key, and then release 
the Cmd key and the Option key. 

 



 

 

   Part 

Becoming Proficient with 
Excel:Mac 
In this part of the book, you become proficient at the essentials of Excel:Mac. 

In Chapter 1, you learn the ins and outs of the four main means of controlling Excel: the 

Ribbon, the toolbars, the menus, and keyboard shortcuts. You grasp how to navigate 

through worksheets and workbooks; learn about quick ways to enter text in workbooks; 

and use splitting, freezing, and custom views to display exactly the items you need. 

In Chapter 2, we cover how to make Excel work your way by setting the most important 

preferences and by customizing the keyboard shortcuts, toolbars, menus, menu bars, 

and Ribbon. You also learn how to open workbooks automatically when you launch 

Excel and how you can save the layout of multiple open workbooks as a workspace that 

you can instantly restore. 

In Chapter 3, you study how to create workbooks in which you can enter, edit, and 

manipulate data quickly and effectively. You learn which file formats to save the 

workbooks in, how to add property information to help you identify workbooks when 

searching, and how to make the most of templates—including creating templates of 

your own. You also learn how to organize worksheets, lay out data effectively, define 

named ranges to make navigation easier, and create a collapsible worksheet. 

In Chapter 4, we go through how to format worksheets quickly and efficiently using the 

various tools that Excel provides. We start with formatting rows and columns—

everything from changing column width and row height to inserting and deleting rows 

and columns and hiding sensitive data. Then we see how to apply straightforward 

formatting, how to apply conditional formatting to quickly flag values that need attention, 

and how to use data validation to check for invalid entries. Finally, we cover how to save 

time by using table formatting and Excel’s styles, and how to add headers and footers to 

worksheets. 
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   Chapter 

Learning the Secrets of 
the Excel:Mac Interface 
1In this chapter, you’ll learn the ins and outs of the Excel:Mac interface and the many 

secrets it holds. 

We’ll start by looking at the four main ways to control Excel: the Ribbon, the toolbars, 

the menus on the menu bar, and keyboard shortcuts. These give you great flexibility in 

the way you control Excel, especially when you set them up as you prefer. 

From there, we’ll discuss how to navigate through worksheets and workbooks. We’ll 

then go through the various ways in which you can get data into your Excel 

workbooks—from importing existing data to entering it more quickly using AutoCorrect, 

AutoFill, and the Scrapbook. 

Toward the end of the chapter, I’ll show you the smart ways to view your workbooks so 

you can work quickly and efficiently. These include splitting the window to show 

different parts of the worksheet at the same time, opening extra windows, and freezing 

key rows and columns so that they stay onscreen when you scroll to other parts of the 

worksheet. You can even create custom views to keep your data laid out exactly as you 

need it. 

Getting Ready to Learn Excel’s Secrets 
You’ll probably want to have Excel running as you go through this chapter so you can 

try out the modifications and techniques that interest you. So launch Excel if it’s not 

already running: either click the Excel icon on the Dock or (if there isn’t one) click the 

desktop to activate the Finder, choose Go � Applications, and then double-click the Excel 

icon in the Microsoft Office 2011 folder. 

Excel may display the Excel Workbook Gallery dialog box. If so, click the Excel 

Workbook icon in the All category and then click the Choose button. This makes Excel 

create a blank workbook rather than one based on a content template. We’ll look at how 

to use the Excel Workbook Gallery to create workbooks in Chapter 3. 

1 
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Four Ways to Control Excel 
To control Excel, you give commands. For example, when you need a new workbook, 

you give the command to create a new workbook. 

In Excel 2011 (see Figure 1–1), you can give commands in the four main ways we noted: 

� Menus. Like most Mac applications, Excel provides a set of menus 

that appear on the Mac OS X menu bar when Excel is the active 

application. To give a command, you click the menu, and then click 

the command. 

� Ribbon. The Ribbon is the new control strip introduced in Excel 2011. 

To give a command, you click its button or control. 

� Toolbars. Excel includes the Standard toolbar and the Formatting 

toolbar. The Standard toolbar appears across the top of the Excel 

window by default, as in Figure 1.1. To give a command, you click its 

button or control. 

� Keyboard shortcuts. To give a command, you press the associated 

key combination. 

 

Figure 1–1. You can control Excel using the Ribbon, the toolbars, the menus on the menu bar, or keyboard 
shortcuts. 

Let’s dig into each of these in turn, starting with the Ribbon. 
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Secrets of the Ribbon 
The Ribbon is the control strip that runs across the top of the Excel window below the 

window’s title bar and any toolbars you’ve chosen to display. The Ribbon is a control 

bar that contains multiple tabs, each containing several groups of controls. At any time, 

the Ribbon displays one tab’s contents; to switch to the contents of another tab, you 

click that tab. As you can see in Figure 1–2, the active tab is a different color than the 

other tabs, so you can easily pick it out. 

NOTE: To make clear where you find the controls, I give Ribbon instructions in the sequence 

tab–group–control. For example, “choose Formulas � Audit Formulas � Trace Precedents” 
means that you click the Formulas tab to display its contents, go to the Audit Formulas group 

(without clicking it), and then click the Trace Precedents button. 

 

Figure 1–2. The active tab of the Ribbon appears in a different color than the other tabs. Each tab contains 
groups of controls, such as buttons and pop-up menus. 

Understanding How the Ribbon’s Tabs Work 
Most of the time, the Ribbon displays eight tabs that contain controls for most normal 

operations in Excel: 

� Home. This tab contains controls for cut, copy, and paste; font, 

alignment, and number formatting; conditional formatting and styles; 

inserting and deleting rows, columns, and cells; and applying themes. 

� Layout. This tab contains controls for manipulating page setup, 

changing the view, choosing which items to print, and arranging 

workbook windows. 

� Tables. This tab contains controls for working with data tables, which 

you use for creating databases in Excel.  

� Charts. This tab contains controls for inserting charts and sparklines 

(miniature charts that fit in a single cell), choosing the layout for charts 

and sparklines, and applying layouts and styles to charts. 
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� SmartArt. This tab contains controls for inserting and formatting 

SmartArt graphics. 

� Formulas. This tab contains controls for inserting functions, auditing 

formulas, and controlling how Excel performs calculations. 

� Data. This tab contains controls for sorting and filtering data, creating 

PivotTables and performing what-if analysis, connecting to external 

data source, validating data, and grouping and outlining worksheets. 

(Chapter 3 discusses grouping and outlining.) 

� Review. This tab contains controls for checking spelling, working with 

comments, applying protection to a worksheet or workbook, and 

sharing a workbook. 

As well as these standard tabs, the Ribbon contains other tabs that it displays only when 

you need them. These are sometimes called context-sensitive tabs. For example, when 

you select a chart, Excel automatically displays the Chart Layout tab and the Format tab 

(see Figure 1–3). 

 

Figure 1–3. The Ribbon displays context-sensitive tabs when you select an object for which tabs are available. 
Here, the Chart Layout tab and Format tab appear on the Ribbon because a chart is active. 

NOTE: Office:Mac got the Ribbon late compared to Office for Windows, but in many ways 
Office:Mac has lucked out—its Ribbon is the better of the two. In Office for Windows, the Ribbon 
replaces the menu bar and the toolbars, so you have to use it unless you set up myriad keyboard 

shortcuts. In Office:Mac, the Ribbon supplements the menu bar and the toolbars, and you can 
choose how much to use it. Normally, you’ll want to leave the Ribbon on so you can access the 
extra features it provides; but if you find the menus and toolbars contain all the commands you 

need, you can turn the Ribbon off. 
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Understanding How the Ribbon’s Groups and Controls Work 
Chances are you got the hang of using the Ribbon’s tabs the first time you used Excel. 

The groups and controls are a little trickier because they change depending on whether 

the Excel window is wide enough to display the entire Ribbon. 

When the Excel window is wide enough, all the groups appear, and they display their 

controls—the buttons, pop-up menus, check boxes, and so on—in their most spacious 

arrangement. For example, the top part of Figure 1–4 shows the rightmost sections of 

the Layout tab of the Ribbon. All the controls in the Print group and the Window group 

appear with labels, so you can easily identify each control. 

But when there’s less space, Excel gradually collapses parts of the Ribbon so as to 

display as much as possible in the available space. For example, the middle part of 

Figure 1–4 shows the rightmost sections of the Layout tab again, but this time the labels 

have disappeared from the Split button, Arrange pop-up menu, Save Layout button, and 

Freeze Panes pop-up menu. In the Print group, the Fit To label still appears, but Excel 

has removed the “page(s) wide” and “page(s) tall” labels to save space. 

When the window is even narrower, Excel collapses the groups and controls further. In 

the lower part of Figure 1–4, you can see that the Print group now contains only the 

Preview button and the Setup button. But you can click the Setup button to display the 

Print Setup dialog box, in which you can configure all the Print group settings the 

Ribbon has hidden, not to mention other settings. 

 

 

 

Figure 1–4. As the Excel window becomes narrower, Excel hides first the labels for the less important controls 
and then the controls themselves, as you can see here with the controls in the Print group and Window group of 
the Layout tab. 
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By automatically changing the Ribbon to suit the window width, Excel keeps as many 

controls as possible at the tip of your mouse. But because labels may not appear, you 

will sometimes need to display the ScreenTip to identify a control; to display the 

ScreenTip, hold the mouse pointer over the control for a moment (see Figure 1–5). 

 

Figure 1–5. When a control’s label doesn’t appear on the Ribbon, hold the mouse pointer over the control to 
display a ScreenTip explaining what it does. 

Further, because some controls may appear in different places when the Ribbon’s whole 

width isn’t displayed, you may sometimes need to hunt for the controls you need. This 

book assumes that the window is displayed wide enough for you to see all the controls 

on the Ribbon, but it notes some of the disappearing controls that can cause confusion.  

If you can’t see a command that’s supposed to be there, have a poke around the 

remaining controls in the group to find where Excel has hidden the control, or to see if 

one of the controls opens a dialog box that contains the controls. (Or use the menu 

alternative if there is one.) 

Collapsing the Ribbon 
When you need more space to work on a worksheet, collapse the Ribbon to just its tab 

bar (see Figure 1–6) in one of these ways: 

� Click the tab that’s currently active. 

� Click the Collapse Ribbon button (the ^ button) at the right end of the 

Ribbon. 

� Choose View � Ribbon from the menu bar (removing the check mark 

next to the Ribbon item). 

� Press Cmd+Option+I.  
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Figure 1–6. Click the Collapse Ribbon button to collapse the Ribbon to just its tabs. Click the Expand Ribbon 
button (which replaces the Collapse Ribbon button) to expand the Ribbon again. 

As you’d guess, you use almost the same moves to display the Ribbon again: 

� Click the tab you want to see. 

� Click the Expand Ribbon button (the ∨ button) at the right end of the 

Ribbon. 

� Choose View � Ribbon from the menu bar. 

� Press Cmd+Option+I. 

TIP: If you don’t want to use the Ribbon, you can turn it off completely. And if you do want to use 
it, you can choose which tabs appear and the order they appear in. See the section “Customizing 

the Ribbon” in Chapter 2 for details.  

Secrets of the Toolbars 
Excel comes with two built-in toolbars—Standard and Formatting—but you can create 

as many others as you need. You can choose which toolbars to display and how to 

display them. And you can customize both the built-in toolbars and your own toolbars, 

as you’ll see in Chapter 2. 

Choosing Which Toolbars to Display  
First, decide which toolbars you want to display. The easiest way to do this is to 

Ctrl+click or right-click a toolbar that’s displayed, click or highlight the Toolbars item on 

the context menu, and then click the toolbar you want to display or hide. Excel puts a 

check mark next to a displayed toolbar on the Toolbars submenu. If the toolbar is 

displayed, you click to remove the check mark and hide the toolbar.  

If no toolbar is displayed, choose View � Toolbars to display the Toolbars submenu on the 

View menu, and then click the toolbar you want to display. 
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Switching the Standard Toolbar Between Icons and Text 
and Icons Only  
Next, choose whether to display the buttons on the Standard toolbar as icons with text 

labels or as icons only. If you find the text labels make the icons easier to identify, 

they’re worth the small amount of extra space they take up.  

To switch between icons and labels and icons only, Ctrl+click or right-click the Standard 

toolbar and then click the Icon and Text item or the Icon Only item on the context menu, 

as appropriate. 

NOTE: The Formatting toolbar displays only icons—you don’t have the option of displaying text 

labels for its buttons. 

Undocking and Docking the Formatting Toolbar 
At first, Excel displays the Standard toolbar at the top of the window, between the title 

bar and the Ribbon (unless you’ve turned off the Ribbon). The same goes for the 

Formatting toolbar if you display it. 

The Standard toolbar remains docked all the time, but you can undock the Formatting 

toolbar if you prefer to have it floating, so you can position it freely on your Desktop.  

To undock the Formatting toolbar, Ctrl+click or right-click the toolbar and then click 

Dock Toolbar in Window on the context menu to remove the check mark. Excel undocks 

the toolbar and displays it as a floating toolbar that you can reposition as needed (see 

Figure 1–7). 

 

Figure 1–7. You can undock the Formatting toolbar  to position it anywhere on the screen. To free up the Excel 
window, position the toolbar outside the window. When you need the formatting controls close to your data, 
position the toolbar over the Excel window like this. 
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TIP: You can toggle the display of the docked toolbars on and off by clicking the jellybean button 

(the gray rounded-rectangle button) at the right end of the title bar. 

Secrets of the Menu Bar 
If you’ve used other Mac applications, you probably know how to use the menu bar:  

1. If the application for which you want to issue a command isn’t active, click one of 

the application’s windows to make it active. Mac OS X then displays the 

application’s menus on the menu bar. For example, when Excel is active, you see 

its menus, with Excel’s own menu appearing at the left end of the menu bar. 

2. Click the menu you want to open. 

3. Click the command you want to give. Or, if the command is on a submenu, click 

or highlight the submenu item to display the submenu, then click the item. 

NOTE: An ellipsis (…) at the end of a menu command’s name usually indicates that the 
command displays a dialog box rather than taking an action. For example, the Close command 

on the File menu closes the active document, while the Save As… command displays the Save 
As dialog box. (The Save command also displays the Save As dialog box—but only if you’ve 
never saved this workbook before.) But with the move to the Ribbon, some menu commands 

with ellipses display the tab of the Ribbon that contains the command you need to complete the 

action. 

Giving a command via the menu bar could hardly be easier. But the menu bar also has 

two secrets. You can:  

� Close all open workbooks at once. Hold down Shift and click the File 

menu, then click the Close All command that replaces the regular 

Close command. If any of the workbooks contains unsaved changes, 

Excel prompts you to save them, just like when you close a single 

workbook. 

� Customize the menus and menu bar. You can customize the menus 

and menu bar to put the commands you need where you find them 

most useful. See the section “Customizing the Menus and the Menu 

Bar” in Chapter 2 for details. 


